
Chapter 2

Getting Started with a 
Structural Project 

After completing this chapter, you will be able to:
• Start a new project
• Set the units of various measurement parameters for a project
• Understand the concept of snaps, dimensions, and object snaps
• Save a project
• Close a project and exit Revit Structure 2015
• Open an existing project

Learning Objectives
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Introduction
In this chapter, you will learn how to create a new structural project. Also, you will learn the 
methods of creating initial setups such as units and snaps.

Starting a new structural project         
Application Menu:  New > Project
Shortcut Key:	       CTRL+N 

In Revit Structure, a structural project is considered as a single database containing 
information related to a building design. This means that the project file created will 
contain all the information related to building design, from geometry to construction 
documentation. Generally, this information include the details of the components used to 
design building models (like walls, doors, windows, beams, columns, and other relevant 
information about the building design), different views of the model, working drawings created 
from model, and documentation related to design of the model.

In Revit Structure, you can create different views such as plan, elevation, and sections from 
a single 3d model created for a building project. These views are associative with each other. 
This means, when you change the building design in one view, it is propagated throughout 
the project. 
	
In Revit Structure, a new project file uses the default settings that are defined in the project 
template.

To start a new project, choose the Application button; the Application Menu will be displayed. 
From the Application Menu, choose New > Project, as shown in Figure 2-1; the New Project 
dialog box will be displayed, as shown in Figure 2-2. In this dialog box, in the Template  
File area, the Structural Construction Template is selected by default in the Template file 
drop-down list. As a result, the new project will adopt the settings of the template file. A 
template file has various project parameters saved in it such as units, views, and so on. When 
you apply the template file on a new project, it will adopt the same parameters as the template 
file. The difference between a template file format and a project file format is that the former 
has a .rte extension, whereas the latter has a .rvt extension. You can either select any of the 
template files provided in Revit Structure or create your own template file. 

Figure 2-1  Choosing the Project option from the Application Menu
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Figure 2-2  The New Project dialog box

You can also save any project file as a template file. You can select a file as template by first 
choosing the Browse button in the Template file area of the New Project dialog box and 
then selecting the required file from appropriate location. To create a new project, select the 
Project radio button and to create a template, select the Project template radio button in the 
New Project dialog box.

SETTING project UNITS
Ribbon: 	 Manage > Settings > Project Units        
Shortcut Key: 	 UN

Units are important parameters of a project as they provide a standard for 
measurement of different entities. While installing Revit Structure, you are 

prompted to set the Imperial (feet and inches) or Metric (meter) unit as default. Setting a 
default unit system helps you start your project with a specific type of unit as per the conventions 
followed in the industry. To set units, choose the Project Units tool from the Settings panel 
of the Manage tab; the Project Units dialog box will be displayed, as shown in Figure 2-3. 
Under the Units column in this dialog box, you can specify various units that are relevant to 
the building project. In the Project Units dialog box, units are grouped into six disciplines: 
Common, Structural, HVAC, Piping, Energy, and Electrical. Each discipline has a set of 
measurement parameters. You can select any of these disciplines from the Discipline 
drop-down list in the Project Units dialog box. The Format column in this dialog box displays 
the current unit format for the corresponding parameter in the Units column. You can preview 
and select the possible digit grouping and decimal separators from the Decimal symbol/digit 
grouping drop-down list, which is at the lower left corner of the dialog box. Different types 
of units and their parameters are discussed next.

Note
The values displayed in the Format column of the Project Units dialog box may differ, depending 
upon the type of unit system, Imperial or Metric, selected for the project. In this textbook, the 
Imperial and Metric unit systems has been used in tutorials and illustrations. 
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Figure 2-3  The Project Units dialog box

Common Unit Type
The Common unit type used in a structural project includes the parameters such as length, 
volume, area, angle, slope, mass density, and currency. In the Project Units dialog box, 
the Common option is selected by default in the Discipline drop-down list, refer to Figure 2-3. 
The Common unit type used in Revit Structure is similar to those used in other Revit platforms. 
Moreover, the settings of the parameters of common units are similar to those used in other 
CAD programs. The methods of setting various parameters under the Common unit type 
are discussed next.

Setting Length Units
In a structural project, you can assign a unit for the measurement of length. To do so, click 
on the field corresponding to the Length parameter in the Format column of the Project 
Units dialog box; the Format dialog box will be displayed. This dialog box displays the units 
of length and their settings, as shown in Figure 2-4. Select the required unit from the Units 
drop-down list in the dialog box. The options that can be selected from this drop-down list 
are Decimal feet, Feet and fractional inches, Decimal inches, Fractional inches, Meters, 
Decimeters, Centimeters, Millimeters, and Meters and centimeters. After selecting the 
desired unit, you can specify the rounding value for the selected unit. To do so, select the 
desired option from the Rounding drop-down list. For certain units, you can specify custom 
rounding value using the Rounding increment edit box, which is placed next to the Rounding 
drop-down list. This edit box is inactive by default. To make it active, first select any option 
from the Units drop-down list and then the Custom option from the Rounding drop-down 
list. Once the Rounding increment edit box is active, you can specify the desired rounding 
value in it for the selected unit.
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Note
The Rounding increment edit box is not available for Meters and Centimeters, Feet and 
Fractional Inches, and Fractional inches options.

Figure 2-4  The Format dialog box

The Unit symbol drop-down list will be inactive if any of the Feet and fractional inches, 
Fractional inches, and Meters and centimeters option is selected in the Units drop-down 
list.

Once you make the Unit symbol drop-down list active, you can select the desired option 
from it to specify the measurement symbol to be used along with the unit of length in 
a project. For example, to use the symbol ‘m’ after all metric length measurements, 
you can select m from the Unit symbol drop-down list as the measurement symbol. 
You can select the Suppress spaces check box to remove all spaces around the dash 
from the length strings. For example, you can remove spaces around the dash when a 
length string is expressed in feet and fractional inches to denote a particular measurement.

Setting Area Units
In the Project Units dialog box, you can assign a unit for the measurements of areas. To 
do so, click on the field corresponding to the Area parameter in the Format column of 
the Project Units dialog box; the Format dialog box will be displayed. In this dialog box, 
you can set the unit for measuring the area by using the options in the Units drop-down 
list. This drop-down list contains various options for the units of area such as Square feet, 
Square meters, Square millimeters, Acres, and so on. By default, the Square feet option is 
selected in this drop-down list, if you had selected Imperial units at the time of installing 
Revit Structure. But, if you have selected the Metric units then the Square meters option 
is selected in this drop-down list by default. The settings for rounding increment and unit 
symbol for the area units can be made from their respective drop-down lists and edit box.
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Setting the Volume and Angle Units
Similar to setting the units for the length and area, you can set the units for volume and 
angle. To set unit for the volume measurement, click in the field of the Format column 
corresponding to the Volume parameter in the Project Units dialog box; the Format dialog 
box will be displayed. In this dialog box, click in the Units drop-down list and select: Cubic 
yards, Cubic feet, Cubic meters, Cubic millimeters, or Liters. After selecting a suitable option 
from the Units drop-down list, choose the OK button; the Format dialog box will be closed 
and the selected unit for the volume measurement will be displayed in the field of the Format 
column corresponding to the Volume parameter in the Project Units dialog box.
  
Similarly, you can specify the unit for the angle measurement by selecting the required option 
from the Units drop-down list in the Format dialog box for the Angle parameter. You can select 
Decimal degrees, Degrees minutes seconds, Radians, or Grads from the Units drop-down 
list to specify the unit for the angular measurement.

Setting the Slope Units
To specify the unit for the slope measurement, click on the corresponding field of the Slope 
parameter in the Project Units dialog box; the Format dialog box will be displayed. In this 
dialog box, you can specify the desired unit by selecting it from the Units drop-down list. The 
Units drop-down list contains options such as Ratio : 12, Ratio : 10, Rise / 12”, Rise / 1’-0”, 
Rise / 1000mm, Decimal degrees, and Percentage for the slope measurement. By default,  
Decimal degrees is selected for the slope measurement, for the Imperial and Metric unit 
systems.
 
Setting the Currency Units
In Revit Structure, you can set the unit for currency as well. To do so, click on the corresponding 
field for the Currency parameter in the Project Units dialog box; the Format dialog box will 
be displayed. In this dialog box, select appropriate currency symbols and rounding values 
from the Unit symbol and Rounding drop-down lists, respectively.

Setting the Mass Density Units
In Revit Structure, you can set the unit for mass density. To do so, click on the corresponding 
field for the Mass Density parameter in the Project Units dialog box; the Format dialog box 
will be displayed. In this dialog box, you can specify the desired unit by selecting it from the 
Units drop-down list. The Unit drop-down list contains options such as Kilogram per cubic 
meter and Pound per cubic foot for mass density measurement. By default, the Pound per 
cubic meter option is selected in this drop-down list for the Imperial unit system and Kilogram 
per cubic meter option is selected for the Metric unit system. The settings for the parameters 
of the rounding, rounding increment, and units symbol can be set by selecting the required 
option from the respective drop-down lists.

 Note 
You can format only the display of units on the screen or for printout using the Project Units 
dialog box. The actual values for these units in the project may be different. For example, 
if you set the wall length rounding to the nearest value 1’, the wall may show this rounded 
value, but the actual length of the wall might be in fractional feet. Similarly, for Metric if 
you the set the wall length rounding to the nearest 10 value, the wall may show this rounded 
value, but the actual length of the wall might be different.
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Structural Unit Type
Structural units include the settings such as Force, Moment, Stress, Unit Weight, and so on. 
In Revit Structure, you can set the structural units in the Project Units dialog box. To do so,  
invoke the Project Units dialog box and then select the Structural option from the Discipline 
drop-down list. Figure 2-5 displays the Project Units dialog box with the Structural option 
selected in the Discipline drop-down list. Some of the structural units are discussed next.

Figure 2-5   The Project Units dialog box with the Structural 
option selected from the Discipline drop-down list

Setting the Unit for Force 
To specify the unit for the concentrated forces that act on the structural model, click on the 
field corresponding to the Force parameter in the Format column; the Format dialog box 
will be displayed. In this dialog box, specify a unit by selecting the required option from 
the Units drop-down list. The Units drop-down list contains the options such as Newtons, 
Decanewtons, Kilonewtons, Meganewtons, Kips, Kilogramforce, and so on. For the Imperial 
unit system, Kips is the default option selected in the drop-down list. For the Metric unit 
system, Kilonewtons is the default option selected.  

Setting the Unit for Linear Force
The linear force implies a uniformly distributed load that you can apply to any structural 
member. To specify unit for the linear force, click on the field corresponding to the Linear 
Force parameter in the Format column of the Project Units dialog box; the Format dialog box 
will be displayed. In this dialog box, specify the desired unit for the linear force by selecting 
an option from the Units drop-down list. The Units drop-down list contains options such as 
Newtons per meter, Decanewtons per meter, Kilonewtons per meter, Meganewtons per 
meter, Kips per foot, Kilogramforce per meter, and so on. The default unit selected for the 
Imperial unit system in is Kips per foot. The default unit selected for the Metric unit system 
in the drop-down list is Kilonewtons per meter. 
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Tip: While selecting a rounding value from the Rounding drop-down list in the Format 
dialog box, you should consider the extent of detailing that may be required for the project, 
and then select it. For projects that require too much detailing, a lower rounding value 
may be set. This parameter, however, can be modified at any time during the project 
development.

Setting the Unit for Area Force
Area forces denote the pressure forces that you can apply to any structural element (beams, 
columns, slabs, and so on). In Revit Structure, you can set the unit for Area Force by selecting 
the desired unit from the Units drop-down list in the Format dialog box corresponding to 
the Area Force parameter. In the Units drop-down list, you can select various options such as 
Newtons per square meter, Decanewtons per square meter, Kilonewtons per square meter, 
Meganewtons per square meter, Kips per square foot, Kilogramforce per square meter, and 
so on. The default unit selected for the Imperial unit system in the drop-down list is Kips per 
square foot and for the Metric unit system is Kilonewtons per square meter.

Setting the Unit for Mass per Unit Area
The Mass per Unit Area parameter specifies the density that you can apply on any structural 
elements such as rebars, structural steel, and so on. To set the unit for the Mass per Unit Area 
parameter, choose the button corresponding to this parameter in the Project Units dialog 
box; the Format dialog box will be displayed. In this dialog box, you can select options such 
as Kilograms per square meter and Pounds per square foot. The default unit selected in 
the Imperial unit system for this parameter is Pound per square foot and in the Metric unit 
system is Kilograms per square meter.

STRUCTURAL SETTINGS
Ribbon:	      Manage > Settings > Structural Settings

In Autodesk Revit Structure, you can specify various structural settings of a project 
such as settings of the symbolic representation of structural framing components, 
settings of various load cases to be applied to structural model, settings for the analysis 
to be performed on model, and settings for providing supports to structural model. 

You can specify all these settings by using the Structural Settings dialog box. The Structural 
Settings dialog box can be invoked by choosing the Structural Settings tool from the Settings 
panel of the Manage tab, as shown in Figure 2-6. This dialog box contains five tabs, namely 
Symbolic Representation Settings, Load Cases, Load Combinations, Analytical Model 
Settings, and Boundary Conditions Settings. In this dialog box, the Symbolic Representation 
Settings tab is chosen by default, as shown in the Figure 2-7.

 

Figure 2-6  Choosing the Structural Settings tool
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The settings that you specify in the tabs of the Structural Settings dialog box pertain to the 
appearance of the structural members. In the Structural Settings dialog box, you can also 
specify the load cases, boundary conditions and the settings for the analytical model. In 
this chapter, you will learn about various options in the Symbolic Representation Settings 
tab. This will help you adjust the symbolic representation of various structural elements for 
documentation output. 

Figure 2-7  The Symbolic Representation Settings tab chosen in the 
Structural Settings dialog box

Symbolic Representation Settings Tab
This tab is chosen by default whenever you invoke the Structural Settings dialog box, refer to 
Figure 2-7. The settings on this tab control the display and symbology of different structural 
conditions in plans, sections, and schedules of steel shapes. These options determine how 
certain elements of an object will display or allow you to use a symbol of your choice in different 
conditions. In this tab, there are three areas: Symbolic Cutback Distance, Brace Symbols, 
and Connection Symbols. The options in these areas are discussed next. 

Symbolic Cutback Distance Area
The Symbolic Cutback Distance area, refer to Figure 2-7, contains three edit boxes: Brace, 
Beam/Truss, and Column. The values in these edit boxes control the cutback distances of the 
structural symbolic lines that represent beams, columns, and braces at a coarse detailed level 
of a structural project. These values are global settings that affect all beams, trusses, braces, 
and steel columns in a project. 
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In the Symbolic Cutback Distance area, you can enter a numeric value in the Brace edit 
box to control the symbolic cutback distance between a structural steel beam or column and 
a structural steel brace at a coarse detail level. In the Imperial unit system the default value 
in this edit box is 3/32” whereas in Metric unit system the default value in the edit box is 
2.5000mm. Figure 2-8 shows the symbolic cutback distance between a brace and a column at 
a coarse detail level.

Figure 2-8  The symbolic cutback distance between a 
column and brace

In the Beam/Truss edit box of the Symbolic Cutback Distance area, you can enter 
any numeric value to control the symbolic cutback distance between beams and columns, or 
between beams, trusses, and columns. Figure 2-9 shows the symbolic cutback distance between  
two beams and a column.  The value in the Column edit box is used to increase or decrease 
the gap between the symbolic representations of joined columns in an elevation view. 

Figure 2-9  The symbolic cutback distance between beams 
and column at coarse detail level	

This gap will be visible in a coarse detail elevation view only if the Top Connection Symbol 
instance parameter of the bottom column is set to a value other than None. The default value 
in the Column edit box is 1/16” for Imperial unit system and in Metric system the default 
value is 1.5000mm. Figure 2-10 shows the symbolic cutback distance between columns in an 
elevation view.
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Figure 2-10  The symbolic cutback distance between columns in an elevation view at 
a coarse detail level	

The Brace Symbols Area
The settings in the Brace Symbols area are used to control the symbolic display of bracing 
and kicker bracings that exist in a project. Figure 2-11 shows the settings in the Brace Symbols 
area in the Symbolic Representation Settings tab of the Structural Settings dialog box. 
The Plan representation drop-down list in this area contains two options: Parallel Line and 
Line with Angle. The Parallel Line option is selected by default. As a result, the symbolic 
representation of braces in a plan view is displayed with a line parallel to and offset from the 
actual brace. You can control the offset distance of this parallel line by entering a suitable value 
in the Parallel line offset edit box below the Plan representation drop-down list.

Figure 2-11  Settings in the Brace Symbols area

In the Imperial unit system 3/32” is set as the default value in the Parallel line offset 
edit box and in the Metric unit system default value is 2.5000mm. Figure 2-12 shows the 
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symbolic representation of a brace in a plan view with default offset distance. On selecting 
the Line with Angle option from the Plan representation drop-down list, the symbolic 
representations of braces in a plan view are displayed with an angled line. The angled line 
originates from the point of intersection of a brace and level line, if they intersect, or from 
the closest point to the level line on the brace. The angled line goes upward from the point of 
origin for the portion of the brace which is above the level or it goes downward for the portion 
of the brace which is below the level. Figure 2-13 shows a bracing symbol as an angled line.

Figure 2-12  The symbolic representation of a brace in a plan view

 

Figure 2-13  The symbolic representation of a brace as an angled line

The Show brace above check box in the Brace Symbols area is selected by default. As a result, 
the brace symbols representing the braces placed above the current view are displayed. When 
you select the Show brace above check box, the Symbol drop-down list below the check box 
gets activated. From this drop-down list, you can select an option depending upon the option 
selected from the Plan representation drop-down list. You can select the Connection-Brace 
-Parallel option from the Symbol drop-down list, if the Parallel Line option is selected in 
the Plan representation drop-down list. Similarly, if the Line with Angle option is selected 
in the Plan representation drop-down list, you can select the Connection-Brace-Angle from 
the Symbol drop-down list. On clearing the Show brace above check box, the brace option 
placed above the current view will not be displayed.

Similar to the Show brace above check box, the Show brace below check box is selected by 
default. As a result, the brace symbols representing the braces placed below the current view 
are displayed. The Symbol drop-down list below the Show brace below check box becomes 
active when the Show brace below check box is selected. The options in the Symbol drop-down 
list located below the Show brace below check box are similar to those of the Symbol check 
box located below the Show brace above check box.
  
In the Kicker brace symbol drop-down list, the Connection-Brace-Kicker option is selected 
by default. As a result, the symbolic representation of a kicker brace will be a connection-brace 
in a plan view. 
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Note
A normal bracing can be converted into a kicker bracing, if the Structural Usage instance 
parameter in the Properties palette of the bracing is set to Kicker Bracing, refer to                
Figure 2-14.

Figure 2-14  The partial view of the Properties 
palette displaying the Structural Usage parameter 
set to Kicker Bracing

Connection Symbols Area
The options in the Connection Symbols area, as shown in Figure 2-15, can be used to control 
the symbolic display of moment and shear connections for beams, braces, and columns that 
exist throughout the project. To select the type of framing member for which you want to 
modify the symbolic display for moment and shear connections, click on the Display 
Symbols for drop-down list and then select any of the three options: Beams and Braces, 
Column Base, and Column Top. In the Display Symbols for drop-down list, the Beams and 
Braces option is selected by default. As a result, the settings for this option will be displayed 
in a table located below the Display Symbols for 

Figure 2-15  The options in the Connection 
Symbols area

drop-down list, refer to Figure 2-15. In this table, 
you will notice two columns: Connection Type 
and Annotation Symbol. In the Connection Type 
column, two parameters are displayed: Moment 
Frame and Cantilever Moment. 

The parameters displayed in the Connection 
Type column may vary depending on the 
option selected from the Displayed Symbols for 
drop-down list. The values for these parameters 
are displayed in their corresponding fields in 
the Annotation Symbol column. To specify the 
annotation symbol for a beam or brace of Moment 
Frame parameter, click on the Annotation 
Symbol column corresponding to the Moment 
Frame parameter and select any of the three 
options: None, Connection-Moment-Filled, and 
Connection-Moment-Not Filled. Similarly, you 
can specify an option for Cantilever Moment 
parameter. To add a connection type parameter (for beams and braces) in the table, choose 
the Add a connection type button (first button from the left) displayed below the table, refer 
to Figure 2-15. On doing so, the New Connection Type dialog box will be displayed. In the 
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Connection Type edit box of the New Connection Type dialog box, enter a name for the new 
connection type. Next, click in the Annotation Symbol drop-down list and select an option 
to assign an annotation symbol for the connection type. Optionally, in the New Connection 
Type dialog box, you can choose the Load Symbol button to load a symbol (with file format 
.rfa or .adsk) for the new connection type. Now, choose the OK button; the new connection 
type will be added as parameter in the table. Next, rename, delete, and create a duplicate for 
the connection type displayed in the table.

In the Connection Symbols area, you can specify the base plate symbol for the column. To do 
so, select the Column Base option from the Display Symbols for drop-down list and specify a 
symbol for the base plate from the table displayed below the Display Symbols for drop-down 
list. Similarly, to assign a symbol to the base plate of a column base, you can specify symbols 
for shear column connection and moment column connection by selecting the Column Top 
option from the Display Symbols for drop-down list. Figure 2-16 shows a moment connection 
and cantilever connection symbol for a steel member.

Figure 2-16  The moment connection and cantilever connection symbols 

snaps tool 
Ribbon:		 Manage > Settings > Snaps 

The Snaps tool is one of the important tools used for creating and editing elements in a 
structural model. This tool is used to make the cursor snap or jump depending on the preset 
increments or specific object properties of elements such as endpoint, midpoint, and so on. 
Invoke the Snaps tool from the Settings panel of the Manage tab; the Snaps dialog box will 
be displayed, as shown in Figure 2-17. This dialog box has three areas, Dimension Snaps, 
Object Snaps, and Temporary Overrides. These areas are discussed next.

Note
The settings specified in this dialog box will be applied to all the projects opened in the session 
and will not be saved.

Tip: The Snaps tool is used frequently not only while creating various building elements 
but also while editing and placing them. Besides making the modeling simpler, by using this 
feature efficiently, you can also improve the performance and accuracy of your project.

Dimension Snaps Area
In the Dimension Snaps area, you can set the length and angle dimension snap increments for 
placing various elements and components in a project. The dimension snap determines the 
increment by which the cursor will jump/snap along with length or angular dimension while 
placing elements and components in a project. 
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Figure 2-17  The Snaps dialog box

The Length dimension snap increments check box is selected by default. As a result, you 
can set the snap increment for the length dimension. On selecting the Length dimension 
snap increments check box, you can enter suitable value(s) in the edit box below it that will 
help to set the snap value for length dimensions. The default values in this edit box are: 4’; 
0’6”;0’1”; 0’0 1/4”, if the US Imperial template is selected. While, on selecting the US Metric 
template the default values in this edit box are: 1000; 100; 20; 5. Note that every incremental 
value is separated by a semicolon (;). You can also set increments by typing the values that are 
separated by a semicolon. For example, to create an interior layout plan in which the length 
of the partitions is in 5’ (1524mm) modules, counter top width is 2’ (610mm), and thickness 
of partitions is 4” (100mm), you can enter the values for the dimension snaps as 5’; 2’;4” 
(US Imperial) and 1524; 610; 100 (US Metric). This will enable the cursor to move in these 
increments and help create the layout with relative ease. Similarly, you can set the angular 
dimension snap increments. However, ensure that the Angular dimension snap increments 
check box is selected and then enter suitable value(s) in the edit box below it. This parameter 
is quite useful for the projects that have radial geometry. 

Note
The reason for specifying multiple length and angle snap increment values in the edit boxes 
is that the priority of increments may change, on changing the zoom level of the drawing. 
Therefore, when you zoom in the drawing, Revit will use smaller increment values, whereas 
on zooming out, the larger increment values will be used.
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Object Snaps Area
Object Snaps refer to the cursor’s ability to snap to geometric points on an element such 
as its endpoint, midpoint, perpendicular, and so on. In the Object Snaps area of the 
Snaps dialog box, you can use various options to snap points of elements or objects in a project. 
The advantage of using these options is that you do not need to specify the exact point in a 
drawing. When object snaps are enabled, the suitable object snap is displayed as the cursor is 
moved close to an element. For example, it is virtually impossible to pick the exact endpoint 
to start a wall from the endpoint of an existing wall. But when you enable the endpoint object 
snap, the cursor automatically jumps or snaps to the endpoint of this wall. This helps to start 
the new wall from the endpoint. This, besides making the drawing accurate, later helps add 
dimensions to the project.

Tip: The Dimension Snaps parameter should be set based on the scale and the amount of 
detailing required for the project. You may set smaller increments for working on a detailed 
or small portion of a building.

Note
The object snaps tool works only with the objects that are visible on the screen. A tooltip, with 
the same name as the object snap, is also displayed when you bring the cursor close to a snap 
point.

In a structural model, you can use various Object Snaps modes such as Endpoints, Midpoints, 
Nearest, Work Plane Grid, Quadrants, Intersections, Centers, Perpendicular, Tangents, 
Points, Snap to Point Clouds, and Snap to Remote Objects.

The name of each object snap option resembles its usage in the project. For example, the 
Work Plane Grid snap option helps you snap the intersection points of grid lines in a work 
plane grid that is displayed for the current work plane. 

Each object snap mode is represented by a geometrical shaped marker to identify it from other 
object snaps. For example, the endpoint object snap is represented by a square, midpoint by 
a triangle, nearest by a cross, and so on. To use an object snap mode, move the cursor on the 
object. As you move it close to the snap point, a marker appears. To select the appropriate snap 
point, click when the corresponding marker or tooltip is displayed. 

In Revit Structure, all enabled object snaps work simultaneously. You can turn off all snap 
options, including dimension snaps and object snaps by selecting the Snaps Off check box 
located at the top of the Snaps dialog box. Alternatively, you can type SO on the keyboard to 
turn them off and on while using a tool. The Check All and Check None buttons are used 
to select or clear all check boxes (except the Snap to Remote Objects) in the Object Snaps 
area.  

Temporary Overrides Area
The options in the Temporary Overrides area provide you with an alternative of overriding 
snaps setting for a single use only. For example, if you have not selected the Endpoints check 
box in the Snaps dialog box and you want to use this option while working with a tool, you 
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do not need to open the Snaps dialog box to select this option. Instead, you can type the 
shortcut, SE in this case, to temporarily activate the endpoint object snap. Once you have used 
this object snap option, snapping to the endpoint is automatically turned off.

Using overrides, you can toggle between various object snap options available at the same 
location. To do so, press the TAB key while snapping the points in the drawing. You can also 
use other overrides like pressing the SHIFT key to create elements vertically or horizontally. 
This restricts the movement of the cursor in the orthogonal directions only. Once you release 
the SHIFT key, the cursor resumes its movement in all directions. You can select the Snaps 
Off check box to disable all types of snapping.

Saving a project
Before you close or exit a Revit Structure session, it is recommended to save the project file. 
You can save a project file in a permanent storage device, such as a hard disk or a removable 
storage device like CD or USB. Also, you must save your work at regular intervals to avoid 
data loss due to any error in the computer’s hardware or software. 

Using the Save As Tool
Application Menu :	 Save As > Project

In Revit Structure, you can save your project file at the desired location. To do so, choose the 
Application button and then choose Save As > Project from the Application Menu displayed; 
the Save As dialog box will be displayed, as shown in Figure 2-18. Alternatively, you can save 
the project file by choosing the Save button from the Quick Access Toolbar.

Figure 2-18  The Save As dialog box
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In the Save As dialog box, the Save in drop-down list displays the current drive and path in 
which the project file will be saved. The list box below the Save in drop-down list shows all 
folders available in the current directory. The File name edit box is used to specify the name 
of the file to be assigned to the project. The Places List area on the left of the Save As dialog 
box contains shortcuts for the folders that are frequently used. 

You can use different file saving features by choosing the Options button from the Save As dialog 
box. On choosing this button, the File Save Options dialog box will be displayed, as shown 
in Figure 2-19. Using the Maximum backups edit box from this dialog box, you can specify 
the maximum number of backup files that you need to store for a project. In Autodesk Revit 
Structure, the non-workshared projects have three backup files and the workshared projects 
have twenty backup files by default. The options in the Worksharing area are inactive for 
non-workshared projects. You can use the options in this area to make the current workshared 
file central compact and select the default workset. The options in the Thumbnail Preview 
area enable you to specify the image to be used as the preview of the project file. This image 
is used at the time of opening a project file. You can specify a view of the model as a preview 
image by selecting the corresponding option from the Source drop-down list in the Thumbnail 
Preview area of the File Save Options dialog box. By default, the Active view/sheet option 
is selected in the Source drop-down list of the Thumbnail Preview area for the preview of 
a project file. For example, to make Structural Plan: Level 1 as the preview image, select it 
from the drop-down list. As a result, when you invoke the Open dialog box and select a file 
to open, the view displayed in the Preview area will correspond to the selection that is made 
from the Source drop-down list in the File Save Options dialog box.  

Figure 2-19  The File Save Options dialog box

In the File Save Options dialog box, you can select the Regenerate if view/sheet is not 
up-to-date check box to see the preview with the latest modifications. On selecting this check 
box, the preview image will be updated when you close the project file. 
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  Note
Revit Structure updates the preview image continuously. Therefore, selecting the Regenerate          
if view/sheet is not up-to-date check box can consume considerable resources.

Using the Save Tool
Once a project has been saved using the Save As tool, you do not need to re-enter file 
parameters to save it again. To save a project to the hard disk, choose the Application button 
and then choose the Save option from Application Menu. If you are saving the project for the 
first time, the Save As dialog box will be displayed, even if you invoke the Save tool.

Tip: By default, the preview of a file is the last active view or sheet at the time it was last 
saved. You can set the preview to a particular view using the Options button in the Save 
As dialog box. 

Alternatively, you can save your project by choosing the Save button from the Quick Access 
Toolbar. As you save your project file, Revit Structure updates it automatically without prompting 
you to re-enter the file name and path.

options dialog box
In Autodesk Revit Structure, you can configure global settings by using the Options dialog 
box. This dialog box can be invoked by choosing the Options button from the Application 
Menu. The Options dialog box, as shown in Figure 2-20, contains nine tabs: General, Graphics, 
File Locations, Rendering, Check Spelling, SteeringWheels, ViewCube, User Interface, 
Fabrication, and Macros. These tabs are discussed next.

Figure 2-20  Setting the file options using the Options dialog box
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General Tab
The General tab is chosen by default and contains five areas: Notifications, Username, 
Journal File Cleanup, Worksharing Update Frequency, and View Options. These areas are 
discussed next.

Notifications Area
Revit Structure provides an option for setting reminders to save a work at regular intervals. 
To do so, select the desired option from the Save reminder interval drop-down list in the 
Notifications area. By default, 30 minutes is selected in this drop-down list. If you do not 
want a reminder to save your work in the project, select the No reminders option from this 
drop-down list. Similarly, you can select a value in the Synchronize with Central reminder 
interval drop-down list.

Username Area
In Revit Structure, you can create a unique identification for a particular session. To do so, 
enter a name for the session in the edit box displayed in this area. The name entered in 
this edit box will be used for granting permissions for editing in a multiuser Revit Structure 
environment.

Note
When you run Autodesk Revit Structure in your system for the first time, you will notice that 
the Windows login name is displayed as the default username in the edit box in the Username 
area. 

Journal File Cleanup Area
Journal files are the text files that are used to resolve the technical problems which occurr 
during the Revit Structure session. These files record every step during the session. Whenever 
you encounter a technical problem with the software, you can run this file to detect the problem 
or recover the lost files or to know the steps that may have caused the problem. In Autodesk 
Revit Structure, these files are saved in the following default location: C:\Users\<Username>\
AppData\Local\Autodesk\Revit\Autodesk Revit 2015\Journals for Windows 7 or Window Vista users 
and C:\Documents and Settings\<Username>\Local Settings\Application for Windows XP users. 
These files are saved each time you close the Revit Structure session. Therefore, the number 
of these files keeps on increasing until you remove these files from their location. However 
to remove these files while retaining some of them, you can use the Journal File Cleanup 
area in the General tab of the Options dialog box. This area contains two spinners: When 
number of journal exceeds and Delete journals older than (days). You can set the required 
values in these spinners to retain the recently created files. For example, if you want to delete 
journal files if their number exceeds 15 and if they were created before 30 days, then in such a 
situation, set the value in the When number of journals exceeds spinner to 15 and the value 
in the Delete journals older than (days) spinner to 30.

 
Worksharing Update Frequency Area
In this area, you can set the update frequency that indicates the time interval for updating 
the project in a worksharing environment. To set the limits for worksharing, you can set the 
slider between the Less Frequent and More Frequent limits. 
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View Options Area
In the View Options area, you can specify the default view discipline to be used in the Revit 
Structure project. To do so, select an option from the Default view discipline drop-down list 
in this area. In this drop-down list, the Structural option is selected by default.

Graphics Tab
The options in the Graphics tab enable you to configure the display card of your computer 
to improve the display performance. You can also use this tab to assign colors to selections, 
highlights and alerts, and enable anti-aliasing for 3D views. In the Graphics Mode area of 
this tab, the Use Hardware Acceleration check box is selected by default. As a result, the 
hardware accelerators are enabled. Hardware accelerators help display the larger models faster 
on refreshing the views. In addition, the hardware accelerators help you speed up the process 
of switching between the windows of views. In this area, you can select the Smooth line with 
Anti Aliasing check box to improve the quality of lines in 3D views. In the Graphic tab area 
of the Options tab, you can select the Use for all views radio button to apply the settings to 
all the view in Revit. In the Colors area of the Graphics tab, select the Invert background 
color check box to toggle the color of the background and elements. The Selection parameter 
refers to a color that an element acquires when it is selected. The default color is RGB 000-
059-189. To use any other color, click the button on the right of the Selection parameter and 
select the desired color from the Color dialog box. The Pre-selection parameter is used to 
specify the color of the highlighted elements. To use any other color, click the button on the 
right of the Selection parameter to display the Color dialog box and then select the desired 
color from this dialog box. Revit Structure uses the Alert button to highlight elements when 
an error occurs. In the Colors area, you can select the Semi-transparent check box to make 
the selected elements semi-transparent. Semi-transparency of a selected element allows you 
to view the elements behind it. In the Temporary Dimension Text Appearance area, you can 
select an option from the Size drop-down list to specify the size of the text used in temporary 
dimensions. In this area, you can set the background of the text in the temporary dimensions. 
To do so, select the Opaque or Transparent option from the Background drop-down list.

File Locations Tab
By using the File Locations tab, you can set the path for various files and directories that are 
accessed frequently, refer to Figure 2-21. The path for these files is set while installing Revit 
Structure. However, you can modify the location of a file by choosing the corresponding Browse 
button and specify a new location.You can also change the default template file location, in 
case, you wish to use a custom made template file for your projects. In Revit Structure, the 
default path to save or open a project can be specified in the Default path for user files edit 
box. You can also specify the default path for family template files and for the point clouds 
by using the corresponding Browse button.

Rendering Tab
Autodesk Revit Structure uses the mental ray rendering engine for its rendering process. The 
mental ray has its own library, Render Appearance Library. This library stores information about 
render appearances for materials, default RPC contents in the software, and other information 
relevant to the rendering process. The Render Appearance Library is a read-only library and 
is loaded into the following default location while installing the Revit Structure software: C:\
Program Files (x86)\Common Files|Autodesk Shared|Materials|2015\\assetlibrary_base.fbm. 
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In addition to the default Render Appearance Library location, you can also specify paths 
for the additional image files defining texture, bump map, and custom color for the render 
appearance that you can use in the project. These image files are not present in the software 
and therefore, you need to specify their paths to use them. To do so, choose the Add Value 
button in the Additional Render Appearance Paths area and specify the required path in 
the displayed field or choose the Browse button; the Browse for Folder dialog box will be 
displayed. In this dialog box, select the desired path and choose the Open button to add the 
path in the field.

Figure 2-21  The File Locations tab of the Options dialog box

Check Spelling Tab 
Revit Structure provides you with the option to run spell check to find out spelling errors in text 
and then rectify them. You can choose the Check Spelling tab from the Options dialog box to 
display its options. Figure 2-22 shows various options in the Check Spelling tab. In the Settings 
list box of this tab, you can specify various self-explanatory settings by selecting their respective 
check boxes. In the Main Dictionary area, you can select the type of dictionary to be used as 
main dictionary for the spell check from the Autodesk Revit drop-down list. Apart from the 
main dictionary, you can also use additional dictionaries available in this dialog box such as 
the personal and building industry dictionaries. This facilitates the use of various personal 
and industrial terms in the text. There are many words that are not included in the main 
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dictionary but are frequently used in the building industry. For example, the abbreviation ‘conc’ 
for the word concrete is not available in the main dictionary. The additional building industry 
dictionary has many such words and abbreviations that can be used in the text of the project and 
therefore, it does not prompt you to check for spelling errors when it finds such terms/words. 
You can also add or remove words from your personal and building industry dictionary. To do 
so, choose the Edit button next to the required option in the Additional Dictionaries area to 
view the list of words and then enter or remove any word from these lists by using the cursor 
and keyboard. To run spell check in your drawing, choose the Check Spelling tool from the 
Text panel of the Annotation tab; the Spelling dialog box will be displayed, wherein you 
can rectify spelling errors in the text by selecting the correct spelling and then choosing the 
Change button in the dialog box. Alternatively, you can press the F7 key to display the Check 
Spelling dialog box.

Figure 2-22  The Check Spelling tab of the Options dialog box

SteeringWheels Tab
The SteeringWheels tab in the Options dialog box has options to control the visibility, 
appearance, and operational tools of different types of SteeringWheels. This tab has seven 
different areas, as shown in Figure 2-23. These areas are discussed next.                                                            

Text Visibility Area
You can control the display of tool messages, tooltips, and tool cursor of SteeringWheels by 
using the options in the Text Visibility area of the SteeringWheels tab. You need to select the 
Show tool messages check box to enable the visibility of tool messages in SteeringWheels. To 
display tooltips along with SteeringWheels, select the Show tooltips check box in this area. 
Similarly, to control the display of the cursor text when a tool is active, select the Show tool 
cursor text check box. 
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Big Steering Wheel Appearance and Mini Wheel Appearance Areas
The options in these areas are used to set the size and transparency of the SteeringWheels. 
To set the size of SteeringWheels, select the required option from the Size drop-down list in 
the corresponding areas and set its size to small, normal, or large. Similarly, you can set the 
transparency of SteeringWheels by selecting the required option from the Opacity drop-down 
list.

Figure 2-23  The SteeringWheels tab of the Options dialog box

Look Tool Behavior and Walk Tool Areas
In the Look Tool Behavior area of the SteeringWheels tab, select the Invert vertical axis 
check box to change the vertical axis movement of the view. Selecting this check box enables 
the view to move in the same direction as the cursor does in the vertical axis.

The Speed Factor slider in the Walk Tool area is used to change the speed of walk while using 
the Walk tool of the SteeringWheels. You can also select the Move parallel to ground plane 
check box in the Walk Tool area to constrain the angular movement of the walk to ground 
plane. 

Zoom Tool and Orbit Tool Areas
Select the Zoom in one increment with each mouse click check box in the Zoom Tool area 
to enable the zooming operation with a single click. 
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In the Orbit Tool area, select the Keep scene upright check box to maintain perpendicularity 
between the sides of the model and the ground plane while using the Orbit tool. 

ViewCube Tab 
The ViewCube tab in the Options dialog box is used to edit various settings of the ViewCube. It 
has four different areas: ViewCube Appearance, When Dragging the ViewCube, When 
Clicking on the ViewCube, and Compass, as shown in Figure 2-24. These areas are discussed 
next.

Figure 2-24  The ViewCube tab of the Options dialog box

ViewCube Appearance Area 
This area is used to control the appearance and display of the ViewCube. In this area, the 
Show the ViewCube check box is selected by default. As a result, the ViewCube will be visible. 
If you clear this check box, the ViewCube will disappear and all options in the ViewCube tab 
will be deactivated. In the ViewCube Appearance area, you can use various drop-down lists 
to align, resize, and change the transparency of the ViewCube. 

Select the options from the On-screen position drop-down list to align the ViewCube on 
the screen. Similarly, if you want to resize the ViewCube, select the required option from 
the ViewCube size drop-down list. You can also set the opacity of the inactive ViewCube by 
selecting an option from the Inactive opacity drop-down list.
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When Dragging the ViewCube Area 
Select the Snap to closest view check box in this area to enable the snap to select the closest 
view in the ViewCube.

When Clicking on the ViewCube Area
Select the Fit-to-view on view change check box in the When Clicking on the ViewCube 
area to fit the view on the screen while changing the viewing direction. In this area, the 
Use animated transition when switching views check box is selected by default. As a result, the 
animated transition occurs while switching the views. If you clear this check box, the animated 
transition will not occur while using the ViewCube. Select the Keep scene upright check box 
to keep the sides of ViewCube and the sides of the view perpendicular to the ground plane. 
Clear the check box to turn around the model in full 360-degree swing. Clearing this check 
box can be useful when you are editing a family.

Compass Area
In this area, the Show the compass with the ViewCube check box is selected by default. As a 
result, the compass along with the ViewCube is visible in the drawing. In the ViewCube tab, 
you can choose the Restore Defaults button to restore the default settings that were changed 
in its different areas.

User Interface Tab							     
The User Interface tab contains two areas: Configure and Tab Switching Behavior. 
In the Configure area, you can use different options such as Active theme, Keyboard 
Shortcuts, Double-click Options, and Tooltip assistance to change the appearance and 
operational settings. You can change the display of active theme by selecting appropriate option 
from the Active theme drop-down list. If you choose the Customize button corresponding 
to the Keyboard Shortcuts in the Configure area, the Keyboard Shortcuts dialog box will 
be displayed. In this dialog box, various commands with their respective shortcut keys are 
displayed. You can use the Assign and Remove buttons to add and remove the shortcut 
keys.

In the Configure area, you can select an option from the Tooltip assistance drop-down list 
to set the required level of  assistance that a tool tip will display when a cursor is placed over 
a tool or an element in the project view. From the drop-down list, you can select any of the 
following options: Normal, None, Minimal, and High. By default, the Normal option is 
selected in the Tooltip assistance drop-down list.  

In the Tab Switching Behavior area, you can specify the tab to be displayed once you clear 
a selection or exit a tool. In this area, the Project Environment drop-down list contains two 
options: Stay on the Modify tab and Return to the previous tab. Select the Stay on the Modify 
tab option to display the options in the Modify tab after exiting a tool or clearing a selection. 
Alternatively, you can select the Return to the previous tab option to display the last used tab 
after exiting a tool or clearing a selection. Similarly, you can use the settings in the Family 
Editor heading to specify the display behavior of the family editor mode. In the Tab Switching 
Behavior area, the Display the contextual tab on selection check box is selected by default. 
As a result, the contextual tab is displayed once you select a tool from the Revit interface.
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Closing a structural project
To close a project, choose the Application button and then select the Close option from 
Application Menu displayed. If you have already saved the latest changes, the project file 
will be closed. Otherwise, Revit Structure will prompt you to save the changes through the 
Save File dialog box. You can save the changes by choosing the Yes button or discard them by 
choosing the No button. You can also choose the Cancel button to return to the interface and 
continue working on the project file. You can also use the Close button (X) in the drawing area 
to close the project.

EXITING A structural PROJECT
To exit a Revit Structure session, choose the Exit Revit button from Application Menu. Even 
if the project is open, you can choose the Exit Revit button to close the file and exit Revit 
Structure. If the project has not been saved once, the Save File dialog box will be displayed on 
choosing the Exit Revit button. In this dialog box, if you choose the No button, all unsaved 
changes will be lost. You can also use the Close button (X) in the main Revit Structure window (in 
the title bar) to end the Revit Structure session.

Opening an existing structural project
Application Menu:       Open > Project
Shortcut Keys:	            CTRL+O

In Autodesk Revit Structure, there are several options available to open an existing project. 
These options are discussed next.

Opening an Existing Project Using the Open Tool
To open an existing project file, choose Open > Project from Application Menu, as 
shown in Figure 2-25. Alternatively, you can open the project file by choosing the Open 
button from the Quick Access Toolbar or by pressing the CTRL+O keys. On invoking the 
Open tool, the Open dialog box will be displayed, as shown in Figure 2-26. Using the Look 
in drop-down list in this dialog box, you can access the desired folder and open the desired 
file. 

Figure 2-25  Choosing the Project option from Application Menu
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The Preview area of the Open dialog box shows the preview of the selected project file. It 
helps you select a particular file by viewing its contents, even if you are not sure about the 
name of the file. The window icons such as the Views menu, placed on the right of the Look 
in drop-down list, helps you select a project file based on its size, type, or date when it was 
last saved. On choosing the Thumbnails option from the Views menu, you can preview the 
contents of the project files inside the selected folder in the file list area. In the Open dialog 
box, you can browse to important locations from the Places list. The Places list is located on 
the left side of the Open dialog box. In this list, you can add or remove folders as per your 
requirement. To do so, choose the Options button from Application Menu; the Options 
dialog box will be displayed. In this dialog box, choose the File Locations tab and then the 
Places button from it; the Places dialog box will be displayed, as shown in Figure 2-27. The 
Places dialog box contains two columns: Library Name and Library Path. 

Figure 2-26  The Open dialog box

Figure 2-27  The Places dialog box
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You can add or remove folders in the libraries list to create a list of frequently accessed 
folders. The four buttons on the left side of the Places dialog box can be used to create or 
delete a library, or move it up and down in the list. To create a new library, choose the Add 
Value button, which is the third button from the top; a new library will be added to the 
defined path. By default, the name of the new library in the Library Name section will be New 
Library1. Change the name of the new library and then click in the Library Path column to 
display the Browse button. Choose the Browse button and select the folder to be added in 
the libraries list by using the Browse For Folder dialog box. Next, choose the Open button; 
the new folder will get added to the list. If required, choose the upward arrow button from 
the Places dialog box to move the folder up to the top of the list. Similarly, you can choose 
the down arrow button to move it down. To delete a library, select it and choose the Remove 
Value button. Choose the OK button in the Places dialog box to exit, and then close the 
Options dialog box. When you invoke the Open tool next time, the new folder icon will be 
displayed in the places list. 

Once the file to be opened has been selected, its name will be displayed in the File Name edit 
box of the Open dialog box and its preview will be displayed in the Preview area. 

Note
If you try opening an already opened file that has been modified in the Revit Structure session,  
a message box appears, prompting you to close the file first and then reopen it. In case, you open   
a file that has been created using an older version of Revit, the Program Upgrade message box 
is displayed. This message box informs that the file is being upgraded to the latest file format and 
that this is a onetime process. Once the file is opened, choose the Save button from Application 
menu to save it to upgraded Autodesk Revit Structure version.

Using the Windows Explorer to Open an Existing Project
Apart from using the Open tool from the Revit Structure interface to open a file, you can also 
open files directly from the Windows Explorer by using the methods discussed next.

A file can be opened by double-clicking on its icon in the Windows Explorer. It opens the 
project file in the latest Revit Structure session. If Revit Structure is not running, double-click 
on the file icon to start Revit Structure and then open the file.

Another method of opening a project file is by dragging the project file icon from the Windows 
Explorer and dropping it in the drawing window of the Revit Structure interface. You can also 
select, drag, and drop more than one file in the drawing window. In this case, Revit Structure 
prompts you to open the files in separate windows. Choose the OK button to open all files in 
the same Revit Structure session.

Tutorials 
In this textbook, you will create two structural projects as tutorials: a commercial project of a 
concrete structure and an industrial project of steel and concrete structure. These tutorials will 
be created in a sequence according to the topics discussed in the chapter. To complete a tutorial 
of the current chapter, you should have completed the tutorials in the previous chapters.
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Tutorial 1					           Commercial Complex

In this tutorial, you will create a setup file for the Commercial Complex project with the following 
parameters and project specifications:			                  (Expected time: 15 min)

1.	 Template file: 
			   For Imperial	  US Imperial > Structural Analysis-Default.rte
			   For Metric	  US Metric > Structural Analysis-DefaultMetric.rte
2.	 Project Units:
			   For Imperial     Feet and fractional inches, Rounding- To the nearest 1/2”
			   For Metric         Millimeters, Rounding- To the nearest 10
3.	 Length dimension snap increment:	
			   For Imperial	  5’;2’6”;3”;0’1/2”
			   For Metric	 1500;700;70;10 
4.	 File name to be assigned: 
			   For Imperial	 c02_Commercial-Complex_tut1.rvt 
			   For Metric	 M_ c02_Commercial-Complex_tut1.rvt

The following steps are required to complete this tutorial:

a. 	 Start a Revit session.
b.	 Use the template file for the project,
		  For Imperial	 Structural Analysis-Default.rte, refer to Figure 2-28. 
		  For Metric	 Structural Analysis-DefaultMetric.rte
c.	 Set Endpoint, Midpoint, Nearest, Perpendicular, Work Plane Grid, and Intersection 	

as the object snaps in the Snaps dialog box for both the systems (Imperial & Metric).
d.	 Save the project by using the Save tool.
			   For Imperial	 c02_Commercial-Complex_tut1.rvt, refer to Figure 2-29	

		  For Metric	 M_c02_Commercial-Complex_tut1.rvt
e.	 Close the project by using the Close tool.

Starting Autodesk Revit Structure 2015
1. 	 Start Autodesk Revit Structure by choosing Start > All Programs > Autodesk > Revit 

Structure 2015> Revit Structure 2015. On doing so, the Revit interface window is 
displayed. 

Opening a New Project 
1.	 Choose the Application button; the Application Menu is displayed. Choose New > 

Project from this menu; the New Project dialog box is displayed. 

Selecting the Template File
To select the template file for the project, you need to access the appropriate folder and select 
the required template file from it.

1.	 In the New Project dialog box, choose the Browse button from the Template file area; 
the Choose Template dialog box is displayed. This dialog box shows a list of 	template 
files available in the US Imperial folder, if Imperial unit system is selected at the time 
of Revit Structure installation. (On selecting Metric unit system, list of metric template is 
displayed).
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2.	 In the Choose Template dialog box, the template file Structural Analysis-Default.rte, as 
shown in Figure 2-28 is selected as the default template file in the US Imperial folder. In 
US Metric folder, default template file is Structural Analysis-DefaultMetric.rte. Choose 
the Open button to assign the selected template file to the New Project dialog box.

Figure 2-28  The Choose Template dialog box

3.	 Select the Project radio button (default) to create a project file and then choose the OK 
button; the selected template file of selected unit system is loaded. Notice that the Project 
Browser now shows different levels and views that have already been created in the selected 
template file.

Setting Project Units
1.	 To set units for the project, choose the Project Units tool from the Settings panel of the 

Manage tab; the Project Units dialog box is displayed. 

2.	 Make sure that the Common option is selected in the Discipline drop-down list of the 
Project Units dialog box. Now, click in the value field corresponding to the Length 
parameter; the Format dialog box is displayed. 

3.	 In this dialog box, select the option by clicking on the Units drop-down list.
			   For Imperial	 Feet and fractional inches
			   For Metric	 Millimeters

4.	 Select the option from the Rounding drop-down list.
			   For Imperial	 To the nearest 1/2” 
			   For Metric	 To the nearest 10
 
5.	 Choose the OK button in the Format dialog box and then in the Project Units dialog 

box to close them.
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Setting Dimension and Object Snaps
You need to set dimension snaps and object snaps by using the Snaps tool. These settings are 
made based on the type of the project and the amount of detailing required.

1.	 Choose the Snaps tool from the Settings panel of the Manage tab; the Snaps dialog box 
is displayed.

2.	 In the Dimension Snaps area of this dialog box, ensure that the Length dimension 
snap increments check box is selected.

3.	 Now, click in the edit box below the Length dimension snap increments check box and 
delete the existing values and then enter the new values.

			   For Imperial	 5’;2’6”;3”;0’1/2”, as shown in Figure 2-29
			   For Metric	 1500;700;70;10

4.	 In the Object Snaps area, clear the Quadrants, Centers, Tangents, and Points check 
boxes to disable them. Leave the other options such as Endpoint, Midpoint, Nearest, 
Perpendicular, Work Plane Grid, Snaps to Remote Objects, Snap to Point Cloud and 
Intersections enabled. Choose the OK button to apply settings and exit the Snaps dialog 
box.

Figure 2-29  The Snaps dialog box
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Saving the Project
The project parameters set in the previous steps are the global settings of the project file. To 
save this project file, use the Save As tool.

1.	 To save the project, choose the Save option from Application Menu. As you are saving 
the project for the first time, the Save As dialog box is displayed.

 
2.	 In this dialog box, browse to the C drive and then create a folder with the name 

revit_2015_structural_project.

3.	 Open the revit_2015_structural_project folder and then create a sub-folder with the name 
c02. Next, open the created folder and save the file with the name c02_Commercial-
Complex_tut1.rvt (For Imperial), refer to Figure 2-30. For Metric, save the file with the 
name M_c02_Commercial-Complex_tut1.rvt 

Figure 2-30  The Save As dialog box

 Closing the Project
1. 	 To close the project, choose the Close option from Application Menu in the ribbon.

 

Tutorial 2				          	          Industrial Complex
In this tutorial, you will create a new project file for the Industrial Complex project by using the 
following parameters and project specifications.		                 (Expected time: 15 min)

1.	 Template file: 
			   For Imperial	 US Imperial > Structural Analysis-Default.rte
			   For Metric	 US Metric > Structural Analysis-DefaultMetric.rte
2.	 Project Units: 
			   For Imperial	 Feet and fractional inches
			   For Metric	 Millimeters
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3.	 Length dimension snap increment: 
			   For Imperial	 10’;2’6”;1’; 0’3”
			   For Metric	 3000;760;300; 70
4.	 Object snaps to be set- all available object snaps.
5.	 File name to be assigned: 
			   For Imperial	 c02_Industrial-Complex_tut2.rvt
			   For Metric	 M_c02_Industrial-Complex_tut2.rvt

The following steps are required to complete this tutorial:

a. 	 Start the Revit Structure session.
b.	 Use the template file.
			   For Imperial	 Structural Analysis-Default.rte
			   For Metric	 Structural Analysis-DefaultMetric.rte 
c.	 Set the project units by using the Project Units dialog box.
			   For Imperial	 Feet and fractional inches
			   For Metric	 Millimeters
d.	 Set the length dimension snap increment in the Snaps dialog box.
			   For Imperial	 10’;2’6”;1’; 0’3” 
			   For Metric	 3000;760;300; 70
e.	 Enable all object snaps using the Snaps dialog box.
f.	 Save the project by using the Save As tool.
			   For Imperial	 c02_Industrial-Complex_tut2.rvt
			   For Metric	 M_c02_Industrial-Complex_tut2.rvt
g.	 Close the project by using the Close tool.

Starting Revit Structure and Opening a New Project 
1. 	 Start a new Revit Structure session by double-clicking on the Autodesk Revit Structure shortcut 

icon on the desktop. The program is loaded and the user interface screen is displayed. 
If the Revit Structure session is already running, you can ignore the step and open the 
project file directly.

2.	 Choose New > Project from Application Menu; the New Project dialog box is 
displayed.

Using the Template File
As given in the project parameters, you need to use the template file for this project. You can 
select this template file from the New Project dialog box.
			   For Imperial	 Structural Analysis-Default.rte
			   For Metric	 Structural Analysis-DefaultMetric.rte

1.	 In the New Project dialog box, choose the Browse button in the Template file area; the 
Choose Template dialog box is displayed. Select the Structural Analysis-Default.rte template 
file from the US Imperial folder or the Structural Analysis-DefaultMetric.rte template file 
from the US Metric folder and then choose the Open button; the Choose Template dialog 
box is closed. Next, choose OK to exit the New Project dialog box; the template file is 
loaded for this project.
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Setting Project Units
You can set units for various measurement parameters by using the Project Units dialog 
box.
1.	 Choose the Project Units tool from the Settings panel of the Manage tab; the Project 

Units dialog box is displayed. 

2.	 Click in the Format column corresponding to the Length unit; the Format dialog box is 
displayed. In this dialog box, select the option from the Units drop-down list. 

			   For Imperial	 Feet and fractional inches
			   For Metric	 Millimeters

3.	 Click on the Rounding drop-down list and select the desired option.
			   For Imperial	 To the nearest 1/4”, as shown in Figure 2-31
			   For Metric	 To the nearest 10
  

Figure 2-31 The Format dialog box

4.	 Choose OK to return to the Project Units dialog box. Next, choose the OK button; the 
dialog box is closed and the user interfase screen is displayed.

Setting Dimensions and Object Snaps
Next, you need to access and modify settings in the Snaps dialog box. You need to specify the 
dimension snap increment and enable all object snap options. 	

1.	 Choose the Snaps tool from the Settings panel of the Manage tab; the Snaps dialog box 
is displayed. 

2. 	 In this dialog box, enter values in the edit box below the Length dimension snap 
increments check box in the Dimension Snaps area.

			   For Imeprial	 10’;2’6”;1’; 0’3”
			   For Metric	 3000;760;300; 70
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3.	 In the Object Snaps area, ensure that all the object snaps options are selected and then 
choose the OK button to apply settings and exit the Snaps dialog box. 

Saving the Project
In this section, you need to save the project and the settings using the Save As tool.
	
1.	 To save the project with the settings, choose Save As > Project from Application Menu. 

As you are saving the project for the first time, the Save As dialog box is displayed. 

2.	 Browse to the C:/revit_2015_structural_project/c02 location and for imperial enter 
c02_Industrial-Complex_tut2 in the File name edit box (for metric enter 
M_c02_Industrial-Complex_tut2). Notice that in the File of type drop-down list, the 
Project Files (*.rvt) option is selected by default. 

3.	 Choose the Save button to save the project as c02_Industrial-Complex_tut2.rvt for 
Imperial (M_c02_Industrial-Complex_tut2.rvt for Metric). The project is saved at the 
specified location. 

Closing the Project
1.	 To close the project, choose the Close option from Application Menu. 

	 The file is closed and this completes Tutorial 2 of Chapter 2.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 You can open only one Revit Structure project at a time. (T/F)

2.	 In Revit Structure, all enabled object snaps work together. (T/F)

3.	 A project file can be opened by double-clicking on the file name in the Windows Explorer. 
(T/F).

4.	 The options in the ______________drop-down list are used to control the symbolic display 
of moment connections for cantilever framing that exists throughout a project.

5.	 The ___________________drop-down list in the Structural Settings dialog box contains 
two options: Parallel Line and Line with Angle.

6.	 In Autodesk Revit Structure, you can set the symbolic representation of structural framing 
components by using the_____________________dialog box. 

7.	 To specify the location of the default template file, you can use the __________ tab in the 
Options dialog box.
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8.	 The __________ button in the Save As dialog box can be used to specify the maximum 
numbers of backup(s) for a project file.

9.	 The __________ option of Revit Structure enables you to override snap settings for a single 
pick only.

10.	 You can add folders to the __________ in the Save As dialog box to access the frequently 
used folders directly.

Review Questions

Answer the following questions:

1.	 You can modify the project unit settings anytime during a project. (T/F)

2.	 The name and path of a project file should be specified each time you save the project. 
(T/F)

3.	 You cannot control the visibility of the tooltip assistant. (T/F)

4.	 The Save reminder interval drop-down list available in the General tab of the Options 
dialog box is used to specify the time interval between reminder prompts to save a project 
file. (T/F)

5.	 If you choose the Close button without saving the changes made in a project file, Revit 
Structure will prompt you to save the changes before closing it. (T/F).

6.	 You can specify the settings for ViewCube and SteeringWheels in the _______________
dialog box.

7.	 You can select any of the three options, namely Beams and Braces, Column Base, and 
Column Top from the___________drop-down list.

8.	 You can add words to additional dictionaries for checking spelling errors. (T/F)

9.	 Which of the following options is not an object snap option?

		  a) Endpoints				    b) Work Plane Grid
		  c) Dimension		  		  d) Centers

10.	 Which of the following keys is used to toggle between the object snap options available at 
the same point? 

		  a) TAB					     b) CTRL
		  c) ALT					     d) F3
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Exercise 1			                         Academic Institution

Exercises

In this exercise, you will create a new project file for the Academic Institution project with the 
following parameters.                                                                        (Expected time: 15 min)

1.	 Template file- 
			   For Imperial	 US Imperial > Structural-Analysis Default.rte
			   For Metric	 US Metric > Structural-Analysis DefaultMetric.rte
2.	 Project Units- 
			   For Imperial	 Feet and fractional inches
			   For Metric	 Millimeters
3.	 File name to be assigned: 
			   For Imperial	 c02_Academic-Institution_exer1.rvt
			   For Metric	 M_c02_Academic-Institution_exer1.rvt

Exercise 2			                          		  Factory Shed
In this exercise, you will create a new project file for the Factory Shed project by using the 
following parameters.					                    (Expected time: 15 min)

1.	 Template file: 
			   For Imperial	 US Imperial > Structural-Analysis Default.rte
			   For Metric	 US Metric > Structural-Analysis DefaultMetric.rte
2.	 Project Units: 
			   For Imperial	 Feet and fractional inches
			   For Metric	 Millimeters
3.	 File name to be assigned: 
			   For Imperial	 c02_Factory-Shed_exer2.rvt
			   For Metric	 M_c02_Factory-Shed_exer2.rvt

Answers to Self-Evaluation Test
1. F, 2. T, 3. T, 4. Cantilever connection, 5. Plan representation, 6. Structural Settings,          
7. File Locations, 8. Options, 9. Temporary Overrides, 10. Places list


